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Concepts Review

True/False Questions
Each of the following statements is either true or false. Select your choice 
by indicating T or F.

 1. You can adjust the width of individual columns in a table, but row 
heights must all be the same.

 2. Effects can be used to give the table a 3-D look.

 3. You don’t need to be exact when you define the size of a table because 
it’s easy to insert rows and columns later.

 4. Borders are available in only one width.

 5. Text in a table cell can have its vertical position adjusted, independent 
of other cells.

 6. When you insert a new column, it is always inserted to the left of the 
currently selected column.

 7. Cell margins can be altered in the same manner as text box margins 
can be altered.

 8. You can remove a tab marker by dragging it off the ruler.

Short Answer Questions
Write the correct answer in the space provided.

 1. What do you call the intersection between a column and a row?

 2. Other than dragging down all the cells or using a button on the Ribbon, 
how can you select a column in a table?

 3. What tab contains the Center Vertically button?

 4. What method can be used to select the entire table?

 5. What three types of 3-D effects are available to apply to the table?
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 6. What are the three methods to merge cells in a table?

 7. What is different about splitting a cell diagonally from splitting it 
horizontally or vertically?

 8. What’s the quickest way to make a group of selected columns of varying 
widths all the same width?

Critical Thinking
Answer these questions on a separate page. There are no right or wrong 
answers. Support your answers with examples from your own experience, 
if possible.

 1. Why might you choose to put information in a table instead of in a 
bulleted placeholder?

 2. Tables can be created in three ways: inserting, drawing, or tabbing. Why 
would you choose one method over another? What criteria would affect 
which method you use?

Skills Review

Exercise 5-24
Create a table, key text, apply table styles.

 1.  Open the file CookOff and move to slide 4, which contains the WordArt 
title “The Winning Fare.”

 2. Insert a new table by following these steps:

 a.  From the Insert tab, in the Tables group, click the Table button .

 b.  On the grid that appears, drag to define a (2 � 4) table two columns 
wide by four rows long.

 3. Key text in the table by following these steps:

 a. Click the upper-left cell to select it, and then key: Name

 b.  Press  to move to the next cell, and then key: Recipe Description
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Figure 5-24
Table text Amy Grand Hot Tomato Salsa

Juanita McLeod Raspberry Cream Pie

William Steinberg Roasted Chicken and Vegetables

 5.  Apply a table style from the Best Match for Document category following 
these steps:

 a.  Select the table by right-clicking within the table and choosing Select 
Table from the shortcut menu.

 b.  From the Table Tools Design tab, in the Table Styles group, click the 
More button .

 c.  From the Best Match for Document category, choose Themed Style 1, 
Accent 1.

 d. Move the table down a little to position it better on the slide.

 6.  Create a slide footer for the current slide (slide 4 only) containing 
today’s date and the text your name [5-24your initials].

 7.  Move to slide 1 and save the presentation as [5-24your initials] in your 
Lesson 5 folder.

 8. View the presentation as a slide show from slide 1.

 9. Print slide 4 only. If you have a color printer, print it in color.

Exercise 5-25
Draw a table, apply border and shading options.

 1. Open the file Operate2.

 2.  Insert a new slide after slide 3 that uses the Title Only layout. Key the 
title Capital Equipment 2007. From the View tab, in the Show/Hide 
group, click the check box beside Ruler if it is not checked already.

 3. Draw a new table by following these steps:

 a.  From the Insert tab, in the Tables group, click the Table button  
and choose Draw Table.

 b.  Use the Pencil pointer to draw a table from under “Capital” to under 
“2007” and down about 3.5 inches on the ruler.

 c. Click and drag two vertical borders to create three columns.

 d. Click and drag four horizontal borders to create five rows.

 e. Press  to turn off the Pencil pointer.

 4. Key the text shown in Figure 5-24 for the remaining cells.
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Figure 5-25
Table text  Column 1 Column 2 Column 3

Row 1  Leased Bought

Row 2 Kitchen  9,450 24,350

Row 3 Dining 14,400 18,650

Row 4 Office 10,500 25,500

Row 5 Other  8,252 16,300

 5. Apply Shading effects to table cells by following these steps:

 a.  Move the pointer to the outside of the table beside row 1, when you 
get a right-facing arrow click to select all the cells in the first row.

 b.  From the Table Tools Design tab, in the Table Styles group, click the 
list box arrow on the Shading button .

 c. Choose Aqua, Text 2, Lighter 40%.

 d.  Click the list box arrow on the Shading button  again and choose 
Gradient.

 e. In the Variations category, choose From Center.

 f.  With the first row still selected, change the font color to a deep blue, 
Indigo, Accent 6, Darker 50%. Apply bold to the first row.

 6.  Make all the columns the same width and all the rows the same height 
by following these steps:

 a.  Select the entire table by right-clicking within the table and choosing 
Select Table.

 b.  From the Table Tools Layout tab, in the Cell Size group, click the 
Distribute Columns button .

 c.  From the Table Tools Layout tab, in the Cell Size group, click the 
Distribute Rows button .

 d.  With the table still selected, change the font size of the entire table to 
24 points.

 7. Remove all the table’s borders by following these steps:

 a. Select the entire table.

 b.  From the Table Tools Design tab, in the Table Styles group, click the 
arrow on the Borders button  and choose No Border.

 8.  Select all cells with numbers and the column heading cells, and make 
them right aligned.

 9.  Create a handout header and footer: Include the date and your name as 
the header, and the page number and text [5-25your initials] as the footer.

10.  Move to slide 1 and save the presentation as [5-25your initials] in your 
Lesson 5 folder.

11.  View the presentation as a slide show; then preview and print the 
presentation as handouts, four slides per page, grayscale, landscape, 
framed. Close the presentation.

 4. For the table text, key the information shown in Figure 5-25.
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Exercise 5-26
Draw a table; insert and delete rows and columns; adjust column and row 
width; apply formatting for text, shading, and borders.

 1. Open the file Operate3.

 2. Display slide 5, titled “Reservation Requests.”

 3. Draw a table on slide 5 by following these steps:

 a.  From the Insert tab, in the Tables group, click the Table button  
and choose Draw Table.

 b.  Use the Pencil pointer to draw a table from under “Average” to under 
“Number” and down about 3.5 inches on the ruler.

 c.  From the Table Tools Design tab, in the Draw Borders group, click 
the Pen Color button  and choose Light Blue, Accent 6, Darker 50%.

 d.  If your pointer is not a Pencil pointer , click the Draw Table 
button .

 e.  Within the table, draw four vertical lines (to create five columns) and 
three horizontal lines (to create four rows). They don’t need to be the 
same size.

 f. Press  to turn off the Pencil pointer.

 4.  For the table’s text, key the data in Figure 5-26. It’s okay if the text wraps 
within cells; you will fix the layout in the next few steps.

PP-5LESSON 5 Creating Tables

Figure 5-26
Table text

Column 1 Column 2 Column 3 Column 4 Column 5

Row 1  Brunch Lunch Dinner Late Night

Row 2 Weekday  3 35  75  3

Row 3 Weekends 21 12 100 15

Row 4 Memorial Day  7  5  12  4

 5. Select the table and make it bold. Make all the numbers blue.

 6.  If the text “Weekday” or “Weekends” wraps to a second line, make the 
table a little wider by dragging either the right- or left-center sizing 
handle. Make sure the pointer appears as .

 7.  Insert a new row between “Weekends” and “Memorial Day” by following 
these steps:

 a. Right-click “Memorial Day.”

 b. Choose Insert from the shortcut menu and choose Insert Above.

 c.  If the table extends below the bottom of the slide, make the table 
smaller by dragging the bottom-center sizing handle up.
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 8. Insert a new column to the left of “Brunch” by following these steps:

 a. Click anywhere in the “Brunch” column.

 b.  Click the Table Tools Layout tab, in the Rows & Columns group, 
choose Insert Left.

 9. Delete a column and a row by following these steps:

 a.  Select the entire “Late Night” column (which might extend beyond 
the right edge of the slide).

 b.  Right-click the selection and choose Delete Columns from the 
shortcut menu.

 c.  Select the “Memorial Day” row. Right-click the selection and choose 
Delete Rows from the shortcut menu.

10.  In the second column, key Breakfast for the column heading. Key 5 
for “Weekday” and 18 for “Weekends.” Change the “Weekday” cell to 
Weekdays.

 11. Key the following information in the new row:

  Holidays  6  9  15  94.

12.  Move the table to a new position and change its size by following these 
steps:

 a.  Right-click anywhere inside the table and choose Select Table from 
the shortcut menu.

 b.  Move your pointer over the table’s border until you see the four-
pointed arrow . If necessary, drag the table so it is positioned on 
the white area of the slide so all numbers are easy to read.

 c.  Make the table wider by dragging the right-center sizing handle to 
the right until all text and numbers are on one line. Before you drag, 
make sure the pointer appears as .

13.  Make all the columns the same width and all the rows the same height. 
Then adjust the first column size as needed to fit all on one line.

14. Align text horizontally by following these steps:

 a.  Select the first row by clicking the first cell and dragging down to 
the last cell.

 b.  From the Home tab, in the Paragraph group, click the Center button 
 (or press � ).

 c.  Select all the cells that contain numbers by dragging diagonally 
across the cells.

 d.  Click the Align Right button  (or press � R ) to right-align the 
numbers.

15. Change cell margin settings by following these steps:

 a. Make sure all the cells that contain numbers are selected.

 b.  From the Table Tools Layout tab, in the Alignment group, choose the 
Cell Margins button  and choose Custom Margins.

 c.  In the Internal margin section, key 0.5� in the Right text box. Click OK.
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16.  Change the vertical alignment of text and numbers in their cells by 
following these steps:

 a.  Select the entire table from Table Tools Layout tab, in the Table 
group, choose the Select button  and Select Table.

 b.  Still working on the Table Tools Layout tab, in the Alignment group, 
click the Center Vertically button .

17.  Create a handout header and footer: Include the date and your name as 
the header, and the page number and text [5-26your initials] as the footer.

18.  Move to slide 1 and save the presentation as [5-26your initials] in your 
Lesson 5 folder.

19.  View the presentation as a slide show; then preview and print the 
presentation as handouts, six slides per page, grayscale, framed. Close 
the presentation.

Exercise 5-27
Insert a table, merge cells, work with tabbed tables.

 1. Open the file Tucson1.

 2.  Insert a new slide after slide 2 and use the Title and Content layout. Key 
Appetizers as the title.

 3. Set a decimal tab at the 4.5-inch on the ruler by following these steps:

 a. Click in the body text placeholder.

 b.  Click the Tab Type marker until the Decimal Tab Marker  appears.

 c. Click on the ruler at the 4.5-inch mark.

 4.  Key the following in the body text placeholder, pressing  before each 
price:

  Wild Rice Soup  5.25 
Dill Cucumber Salad  4.50 
Four Bean Salad  4.25

 5.  Insert a new slide after slide 3 and use the Title Only layout. Key Entrees 
as the title.

 6. Insert a table with three columns and seven rows.

 7.  Merge the cells in rows three, five, and seven using the 
following steps:

  a. Select the cells in row three.

  b.  From the Table Tools Layout tab, in the Merge 
group, choose the Merge Cells button .

  c. Repeat the process for row five and row seven.

TIP

You can use right tabs instead of 
decimal tabs to align numbers if all 

the numbers in the list have the same 
number of decimal places.
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 8. Key the text as shown in Figure 5-27 into your table.
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Figure 5-27
Table text

 Column 1 Column 2 Column 3

Row 1 Entrée Dinner Lunch

Row 2 Chicken Fajitas 9.50 6.25

Row 3  Chunky chicken, Monterey Jack cheese, tomatoes, and 
olives wrapped in a flour tortilla

Row 4 Dijon Chicken Rolls 9.95 6.50

Row 5  Rolled boneless chicken breast filled with spicy 
bread crumbs and dressed with a Dijon sauce

Row 6 Thai Stir Fry 10.25 7.50

Row 7   Tasty shrimp with fresh garden vegetables served 
over your choice of wild or white rice

 9.  Move the table down and resize as necessary the table, columns, and rows.

10. Center the text vertically in the table.

11.  Create a handout header and footer: Include the date and your name 
as the header, and the page number and text [5-27your initials] as the 
footer.

12. Save the presentation as [5-27your initials] in your Lesson 5 folder.

13.  Preview and then print the presentation as handouts, four slides per 
page, grayscale, landscape, framed. Close the presentation.
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Lesson Applications

Exercise 5-28
Create a presentation with a table slide, apply table styles, arrange and 
format text, and change column widths and table size.

 1. Open the file Print1.

 2. Insert three slides after slide 1. Use the Title and Content layout for all 
three slides.

 3. On slide 4, select the Table button  from the content placeholder, 
and select the correct number of columns and rows before keying the 
information in. Select the entire table and change the font to red. On 
the table, each cell in the first row should contain two lines of text.

 4. Key the text in Figure 5-28.

Figure 5-28
Presentation content

 5. On slide 4, change the Table style to Themed Style 2, Accent 4 in the Best 
Match for Documents category.

 6. For the entire table, change all right and left cell margins to 0.2 inches. 
Using the pointer , double-click each column border so that each 
column self-adjusts to fit the widest text in the column.

 7. Center the headings for the columns containing numbers.

 8. Right-align all numbers.

Print Advertising 2007 

   • Campaigns use a variety of print media

   • Each medium targets a specific market segment

   • Every campaign must meet specific sales objectives

Coupon Redemption

   • Effective measure of return on investment

   • Used for promotional purposes in a variety of print media

Coupons Redeemed 2006

   Column 1    Column 2    Column 3    Column 4

Row 1   Newspaper    Coupons    Average    Cost of

   Magazine    Redeemed    Check    One Ad

Row 2   NY Times    414     $31.50    $6,800

Row 3   NY Magazine    476     $25.00    $2,850

Row 4   NY Runner    1,063    $23.50    $975

Row 5   NY Health    125     $16.25   $650

Slide 2

Slide 3

Slide 4
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 9. Vertically center all text and numbers in the table.

10. Adjust the overall size and position of the table for attractive positioning 
on the slide, as shown in Figure 5-29.

11.  Create a slide footer for 
the current slide (slide 4) 
containing today’s date and 
the text your name, [5-28your 
initials].

12.  Create a handout header and 
footer: Include the date and 
your name as the header, and 
the page number and text 
[5-28your initials] as the 
footer.

13. Save the presentation as [5-28your initials] in your Lesson 5 folder.

14. Print the current slide (slide 4) in full size.

15. View the presentation as a slide show; then preview and print the 
presentation as handouts, four slides per page, grayscale, landscape, 
framed. Close the presentation.

Exercise 5-29
Insert a table slide; insert rows; change row height, column width, 
alignment, and cell margins; and apply a 3-D effect.

 1. Open the file Ads2.

 2. On slide 1, change “Student Name” to Your Name.

 3. Insert a table on a new slide after slide 1 and key the text shown in 
Figure 5-30.
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Figure 5-29
Completed table 

slide

Figure 5-30
Table text Advertising Effectiveness

 Column 1 Column 2 Column 3

Row 1  New Total

  Customers Revenue

Row 2 Newspaper 28% 30%

Row 3 Radio 10%  5%

Row 4 Yellow Pages  6% 12%

 4. Resize the title placeholder to fit on one line.

 5. Apply the following formatting to the table’s text:

  • Center the text in the first row.

  •  Right-align all the numbers and apply a cell right margin, so that the 
numbers appear centered under their headings.

hin1926X_PPTL5_PP01-PP15.indd Page PP-10  10/4/08  10:00:08 PM user-s208hin1926X_PPTL5_PP01-PP15.indd Page PP-10  10/4/08  10:00:08 PM user-s208 /Users/user-s208/Desktop/TEMPWORK/September 08/18:09:08/MHBR065:204:Spilker/Users/user-s208/Desktop/TEMPWORK/September 08/18:09:08/MHBR065:204:Spilker



  • Apply a 0.25-inch left margin to all the cells in the first column.

  •  If necessary, adjust the column width of the first row so that “Yellow 
Pages” is on one line.

 6. Insert a row above “Yellow Pages” with the following text:

  Mailers 12% 18%

 7. Make the table easy to read by adjusting the column widths, row heights, 
and vertical alignment of cells, as necessary. Resize and reposition the 
table appropriately on the slide.

 8. Change the table style to Themed style 1, Accent 1.

 9. Select all of the text in the table except the first row and change the font 
to Gray-50%, Background 2, Darker 50%.

10. Add a Convex cell bevel to the entire table.

11. Create a slide footer for the current slide (slide 2) containing today’s 
date and your name and the text [5-29your initials].

12. Create a handout header and footer: Include the date and your name 
as the header, and the page number and text [5-29your initials] as 
the footer.

13. Check spelling and change any words that need to be corrected.

14. Save the presentation as [5-29your initials] in your Lesson 5 folder.

15. Print slide 2 in full size.

16. View the presentation as a slide show; then preview and print the 
presentation as handouts, six slides per page, grayscale, landscape, 
framed. Close the presentation.

Exercise 5-30
Create a tabbed table. 

 1. Start a new blank presentation. Use the Concourse design theme with 
the Equity color theme.

 2. On slide 1, key a two-line title with the text Good 4 U and Softball 
Schedule.

 3. Key Spring/Summer 2008 for the subtitle.

 4. Find a softball clip art image and insert it on the title slide in the color 
bar at the bottom. Duplicate the softball several times, and resize the 
images to look as though they are getting smaller. See Figure 5-31 for an 
example.

PP-11LESSON 5 Creating Tables
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 5.  Using the Title Only layout, create 
slide 2 as shown in Figure 5-32. 
Key the table and its heading all 
in one text box and format the 
table as follows:

  • Set appropriate tabs.

  • Add bold to the headings.

  •  Change the font size to 20 
points.

  •  Position the table appropriately 
on the slide. 

 6. Add the same softball used in slide 1 to the bottom left corner of slide 2.
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Figure 5-31
Slide 1

Figure 5-32
Slide 2

 7. Using the Title and Content layout, create slide 3 as shown in Figure 5-33.

 8. Copy and paste the softball from slide 2 onto slide 3, and insert a softball 
image recolored to match the theme colors on the right of the slide.

Figure 5-33
Slide 3
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 9.  Check spelling in the presentation. The names of team members are spelled 
correctly; do not make any changes.

10.  Create a handout header and footer: Include the date and your name 
as the header and the page number and filename [5-30your initials] as 
the footer.

11. Save the presentation as [5-30your initials] in your Lesson 5 folder.

12. Preview and then print the presentation as handouts, three slides 
per page, landscape, grayscale, scale to fit paper, framed. Close the 
presentation.

Exercise 5-31  Challenge Yourself
Edit and format a presentation including a table slide, add data, change 
alignment, change table colors, and merge cells.

 1. Open the file MktSum.

 2. Create a table on a new slide after slide 3 using the layout Title Only 
layout. Key the title Marketing Expenses 2006.

 3. Draw a table using the Pencil pointer. Change the font of the first row to 
28 points, brown, and bold. Center the first row vertically and horizontally 
within the cell. Use Figure 5-34 for as an example to create the table.

LESSON 5 Creating Tables PP-13

Figure 5-34
Table slide

 4.  Use appropriate alignment techniques, fill colors, and border 
treatments. Use a preset gradient color for the heading row fill for a 
gold appearance. (This option is found under More Gradients.)

 5.  Distribute the columns and rows evenly.

 6. Using the Title and Content layout, insert a new slide after slide 4 with the 
title Estimated Budget 2007. Use Figure 5-35 as an example to create the 
table. Choose an appropriate table style to coordinate with the theme.

hin1926X_PPTL5_PP01-PP15.indd Page PP-13  10/4/08  10:00:10 PM user-s208hin1926X_PPTL5_PP01-PP15.indd Page PP-13  10/4/08  10:00:10 PM user-s208 /Users/user-s208/Desktop/TEMPWORK/September 08/18:09:08/MHBR065:204:Spilker/Users/user-s208/Desktop/TEMPWORK/September 08/18:09:08/MHBR065:204:Spilker



 7. Adjust the size of the columns, rows, and table as necessary to present 
an attractive table.

 8. Select the table and choose the Reflection Effect of Half Reflection, 4 pt 
offset.

PP-14 UNIT 2 Presentation Illustration

On Your Own

Figure 5-35
Table slide

 9.  Create a handout header and footer: Include the date and your name 
as the header, and the page number and text [5-31your initials] as the 
footer.

10.  Check spelling in the presentation.

11.  Save the presentation as [5-31your initials] in your Lesson 5 folder.

12. View the presentation as a slide show; then preview and print the 
presentation as handouts, six slides per page, grayscale, framed. Close 
the presentation.

In these exercises you work on your own, as you would in a real-life work 
environment. Use the skills you’ve learned to accomplish the task—and be 
creative.

Exercise 5-32
Use a recipe to create a series of slides describing a prepared dish. Create a 
title slide with the name and where the recipe came from, and, if possible, 
a picture of the finished dish. Add one or two slides describing in general 
terms what the dish contains and why it is good. Create a series of slides 
containing tables that present the ingredients and steps to create the recipe. 
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Design your own table structures to present the information in a way that 
you think is easy to understand using inserted tables with table styles, tables 
that you draw, and tabbed tables. Format your presentation attractively; 
picking up colors, fonts, and other style features that accent the recipe that 
you have chosen. Save your presentation as [5-32your initials]. Preview, 
and then print the presentation as handouts.

Exercise 5-33
Find a schedule of events from your local newspaper or other source, 
for example, a movie schedule, your class schedule, the TV listings, or a 
schedule of community or school events. Create a presentation containing a 
table that lists those events in a way you think is easy to understand. Create 
a second table listing the three events or classes you think are the most 
interesting in one column and a description of those events in a second 
column. The presentation should include a title slide, two table slides, 
and any other slides you think will enhance your presentation. Use your 
creativity to make the tables interesting and fun to view. Be sure to resize 
the table and cells as needed and add borders, shading, and effects to add 
interest. Save the presentation as [5-33your initials]. Preview, and then 
print the presentation as handouts.

Exercise 5-34
Create a single-slide presentation with a personal grocery or other shopping 
list in table format. (If you have a long list, use two or more slides.) Create 
columns based on the categories of items you need to purchase. For 
example, frozen meat, canned goods, refrigerated items, etc. List items that 
you need to buy in each section of a grocery store under the proper column 
heading. Format your table attractively and in keeping with your own 
personality (making sure it is easy to read). If you create a really thorough 
list, you can print copies and circle what you need to purchase each time 
you go to the store. Save the presentation as [5-34your initials]. Preview, 
and then print the presentation as a full-size slide(s).

PP-15LESSON 5 Creating Tables
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